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1. OPOS SET Installation

1) Double Click the ‘SAM4S_OPOSSET.exe’ to start installation

IR £4145-0POSSET.exe
3 21l auncher dnicode
o [N

[Pic No.1] Installation File

* This manual is written based on the PosReady7 Environment. Any specific requirement for the other OS

will be mentioned.

* POS for .NET 1.12 and .Net Framework 3.0 or above should have installed.

* Supported Language: English Only

* Supported OS: WePos, Windows XP, PosReady2009, PosReady7 (32bit, 64bit), Windows 7 (32bit, 64bit)
Industry 8.1 Pro (32bit, 64bit), Windows 8 (32bit, 64bit), Windows 10 (32bit, 64bit)

2) Begin the Installation

i SAMAS OPOS Set - InstallShield Wizard

Welcome to the InstallShield Wizard for
S5AM45 DPOS Set

The InstallShield{R) Wizard will install SAM45 OPOS Set on your
| computer, To continue, click Mext.

WARNING: This program is protected by copyright law and
international treaties,

)

% Back [ mext> [ Canicel ]

[Pic No.2] Begin the Installation

3) Ready to Install

i SAMAS OPOS Set - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click. Install ko begin the inskallation,

IF wou want to review or change any of your installation settings, click Back., Click Cancel ko
exit the wizard,

[ <Back || Instal i [ Cancel

[Pic No.3] Ready to Install
SHC-SW-02-OPOSSET_UserManual(Eng)
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4) Installing the OPOS Set

{7 SAMAS OPOS Set - InstallShield Wizard

Installing SAM45 OPDS Set

The program Features you selected are being installed,

Please wait while the InstallShield Wizard installs SAM4S OPOS Set, This may
take several minutes,

Status:

[ [T] J

InskallShisld

= Back et = Cancel

[Pic No.4] Installing the OPOS Set

5) Completed the Installation

i¥ SAMAS OPOS Set - InstallShield Wizard

InstallShield Wizard Completed

| The InstallShield Wizard has successfully installed SAM4S OPOS
| Set, Click Finish o exit the wizard,

Finish

[Pic No.5] Completed the Installation

USER MANUAL

6) After installing the OPOS Set, Shortcut will be created on the Start Menu>OPOS>SAM4S>0POS Set

Bm OPOS | EE SAMAS

[Pic No.6] Start Menu

SHC-SW-02—0OPOSSET_UserManual(Eng)

| 4F sSaM4s OPOS Set

=)y Sample Code
=y Manual
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2. Add / Delete an OPOS Device
® Add an OPOS Device

1) Three ways to open the ‘Add new Device’ dialog as below

"A1 sAMAS OPOS SET

USER MANUAL

File | Tools ~ Help -

Add LDN

Delete Device

Delete LDM

Device Name Device Description

Status

[Pic No.7-1] Add an OPOS Device (Select from the menu)

"5/ SAMAS OPOS SET

File ~ Tools + Help -

EBle x v|< @

-~ POS Printer

[ Add Device }
LT DTEwer

L MSR

Device Name Device Description

Status

[Pic No.7-2] Add an OPOS Device (Click the button)
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'ﬂ SAMAS OPOS SET

File » Tools ~ Help -

P X|J|R| B

- 15 Iril'|tE!l' g T s
- Line Disp .

- Cash Dra Add Device
e bSH

[Pic No.7-3] Add an OPOS Device

(1. Select a Device Class. 2. Right mouse button click. 3. Select the ’Add Device’)

2) The ‘Device Selection’ Screen will be shown when a Device Class isn’t selected or click the ‘< Back’
button from the ‘Add New Device’ Screen.

'qP Add New Device

=
s n mds OPOS DRIVER INSTALLER

Select a Device Class

POS Printer
Line Display
Cash Drawer
MSR

< Back ” Mext = | | Cancel

Pic No.8] Select a Device Class

SHC-SW-02—0OPOSSET_UserManual(Eng)
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3) List of Device will be shown by selected Device Class

& Add New Device 5

Add Mew Device

s n m4s Select Device Mame

[GIANT-200 -

Select Communication Type
|SERIAL ~|

Add Mew LDN

Alogical device name isnt indispensable.

Communication Setting

Paort

M1

Baudrate 115200

8
1 1 1

Parity MOME
Databits 8 -

Alogical device name isn't set up in the case as the blank.
A logical device name can be set up even later.

= Back

,—

[Pic No.9] Add a Device

® Values of Communication Setting will be set by Communication Type

® The LDN can be set up even later

4) Click the ‘Next >’ button to add an OPOS Device
"#] sAM4S OPOS SET

(== [=]
File ~ Top i
@ Add New Device (=]
i Add New Devi
ew Device
EOS g s n mds Communication Setting
i Line
LCash Select Device Name Port
LWSR [GlﬂNT—ZDD - Banidirate
Select Communication Type . NONE 5
SERI Canfirm 52 | [tabits 8 -
Do you want install this OPOS driver?
Add Nel
Ald
Ald k.
Al Yes ] [ Mo ]
[ < Back " Next > } l Cancel

[Pic No.10] Confirmation for adding OPOS Device

SHC-SW-02—0OPOSSET_UserManual(Eng)
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@ Remove an OPOS Device

1) Two ways to remove a selected OPOS Device as below

USER MANUAL

"5/ SAMAS OPOS SET

File =| Tools + Help -
Add Device

Add LDN

Delete LDN

Device Name Device Description Status

[Pic No.11-1] Remove a selected OPOS Device (Select from the menu)

"/ samas 0POS SET

File ~ Tools ~ Help ~

R A AR

05 Printer

Delete Device
-

é----Cash CFa

Device Mame Device Description Status

[Pic No.11-2] Remove a selected OPOS Device (Click the button)

SHC-SW-02—0OPOSSET_UserManual(Eng)
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PH SAM4S OPOS SET

o] & w5

File ~ Tools ~ Help ~

P X | S| A B

=-POS Printer
R | 1\ T- 20010

LDN Name
TICSTINN

LDM Description Status
POSPrinterMGIANT-200

- Line Displ Delete Device

- Cash Dra
; Device Config

Add LDN

[Pic No.11-3] Remove a selected OPOS Device

(1. Select a Device. 2. Right mouse button click. 3. Select the ‘Delete Device’)

2) Confirmation for removing selected OPOS Device

A sAM4S OPOS SET

File ~ Tools ~ Help ~

P X | S| A B

- POS Printer
. L GIANT-200
- Line Display
- Cash Drawer

LDN Name
TEST LDN

LDM Description Status
POSPrinterMGIANT-200

Question ._ gg

Do you want to delete the selected Device?

[Pic No.12] Confirmation for removing selected OPOS Device

SHC-SW-02—0OPOSSET_UserManual(Eng)
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3. Add / Rename / Delete a LDN

@® Add a LDN

1) Three ways to open the ‘Add LDN’ dialog (A Device must be selected)

"A1 SAMAS OPOS SET ==
File | Tools = Help =

Add Device
Add LDN

Device Name Device Description Status

GIANT-200 SAM4S OPOS ServiceObject, Copy...  Stand Alone

Delete Device
Delete LDM

[Pic N0.13-1] Add a LDN (Select from the menu)

"4 sams OPOS SET ===

File = Tocols » Help -

] Device Name Device Description Status

[

o GIANT-200 SAM4S OPOS ServiceObject, Copy...  Stand Alone
i..Cash Drawer

----- MSA

[Pic No.13-2] Add a LDN (Click the button)

SHC-SW-02—0OPOSSET_UserManual(Eng)
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File = Tools = Help =

Add LDN

%X | ] B
E- F:Oter i LDN Name LDN Description Status
W | b T2
i o EST LDN POSPrinterGIANT-200
----- ine Oi D z
elete Device
----- Cash C
..... [ =t Device Config

[Pic No0.13-3] Add a LDN
(1. Select a Device. 2. Right mouse button click. 3. Select the ‘Add LDN’)

2) Fill the LDN name and click the ‘OK’ button to add LDN

,% Add LDN

SAM4S

Add MNew LDN

Alogical device name isnt indispensable.

Device Infao

DEVICE CLASS:
DEVICE NAME:

POS Printer
GIANT-200

A logical device name isn't set up in the case as the blank.

A logical device name can be set up even later.

QK | | Cancel

[Pic No.14] Add LDN

SHC-SW-02—0OPOSSET_UserManual(Eng)
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@ Rename a LDN

1) Select a LDN, Right mouse button click and select the ‘Rename LDN’

"A1 sAMAS OPOS SET

USER MANUAL

File = Tools ~ Help -

% X| | A|B

= POS Printer
{ L GIANT-200
i Line Display
i Cash Drawer

LDN Name

=m0

Delete LDMN

LDM Description
POSPrinterfGIANT-200

Status

. MER | Rename LDM

Device Test

[Pic No.15] Rename LDN (Select from the menu)

2) Fill a name for new LDN

"A1 SAMAS OPOS SET

File = Tools = Help =

%X | ] B
- POS Printer

L GIANT-200

i Line Display

i Cash Drawer

LON Name
Mew LDN|

LOM Description Status
POSPrintertGIANT-200

[Pic No.16] New LDN name

SHC-SW-02—0OPOSSET_UserManual(Eng)
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® Remove a LDN

1) Three ways to remove a selected LND as below

%] SAM4S OPOS SET
[File =] Tools + Help ~
Add Device
e LDN Name LDN Description Status
Delete Device New LDN POSPrinterfGIANT-200

[Pic No.17-1] Remove a LDN (Select from the menu)

4 SAMMS OPOS SET

" File = Tools = Help ~

eeElvale
= F:Oglirinter LDN Name LDN Description Status
New LDN POSPrinterGIANT-200
Line Disp@rEy
g----Cash Drawer
L MER

[Pic No.17-2] Remove a LDN (Click the button)

SHC-SW-02—0OPOSSET_UserManual(Eng)
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'ﬁ SANAS OPOS SET

Lol &

File = Tools » Help ~

B X|J|R|B

=-POS Printer
L L GIANT-200
- Line Display
- Cash Drawer

LDN Name

Delete LOM

LDN Description
| POSPrinterGIANT-200

Rename LDMN

Device Test

Status

[Pic No.17-3] Remove a LND

(1. Select a LDN. 2. Right mouse button click. 3. Select the ‘Delete LDN’)

2) Confirmation for removing selected LDN

B sAMMS OPOS SET

File = Tools » Help ~

TP X|J|R| 8

- POS Printer
L L GIANT-200
- Line Display
- Cash Drawer

LDN Name
MNew LDN

LDN Description
POSPrinterGIANT-200

Question

Do you want to delete the selected LDN?

e [ w

Status

[Pic No.18] Confirmation for removing selected LDN

SHC-SW-02—0OPOSSET_UserManual(Eng)
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4. Configurations for OPOS Device

1) Three ways to open the ‘Device Config’ dialog (A Device must be selected)

"A1 SAMAS OPOS SET =)
File = [Tools «| Help ~
:% By Device Test
LDON Mame LOM Description Status
POSPrinter#GIANT-200

[Pic No.19-1] Configurations for OPOS Device (Select from the menu)

"A1 sAMAS OPOS SET ==

File = Tools ~ Help -

+ % x| & 8

B F:Oglil‘rj'nl'tezrﬂlj LON Name LDM Description Status
. Line Display | Device Config POSPrinterttGIANT-200

i Cash Drawer
L MER

[Pic No.19-2] Configurations for OPOS Device (Click the button)

SHC-SW-02—0OPOSSET_UserManual(Eng)
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4 SAMAS OPOS SET =l e
B ik i '
% X || R B
E‘ F:OS Printer LDN Name LDN Description Status
ki Dispiz e Mawe | O POSPrirterGIANT-200
- Cash Drav
L MER Device Config
Add LDN
[Pic No.19-3] Configurations for OPOS Device
(1. Select a Device. 2. Right mouse button click. 3. Select the ‘Device Config’)
2) ‘Device Configuration’ screen will be set depending on the selected OPOS Device
If configurations for the selected OPOS Device are unable, notification message will be shown.
A sanMS OPOS SET (=& =]
File - Topssmtts
“%, Device Configuration
+ %
=-POS P
T SAMAS e
_____ Line D Communication Setting
----- Cash [
..... Massﬁ Select Communication Type
[SERIAL -
Port COM1 -
Baudrate 115200 -
=

[Pic No.20-1] Configurations for Device

SHC-SW-02—0OPOSSET_UserManual(Eng)
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"B saMas 0POS SET BEE
File ~ To

% 3

"~ SAMAS

% Device Configuration

UNABLE TO CONFIGURATIONS

[Pic No.20-2] Configurations are unable

3) Click the ‘Apply’ button to apply configurations. Or click the ‘Cancel’ to cancel configurations

"8 samuas OPOS SET (=] = [ ==
File = Topz—=
&, Device Configuration Lo
%
=-POSP
% SAMAS ——
~Line D Communication Setting
- Cash [
= MSF Select Communication Type
.53 |SERIAL -

COMFIRM |22

Do you want to apply the configurations?

(o [ o

[Pic No.21] Confirmation for configurations

SHC-SW-02—0OPOSSET_UserManual(Eng)
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5. Testing for OPOS Device

1) Three ways to open the ‘Device Test’ dialog (A Device must be selected)

"/ sAMS OPOS SET

File ~ Help ~

Device Test

o

i Poimdanity LDN Name LDN Description Status
L-i;uil "" New LDN POSPrinter#GIANT-200
- Cash Drawer
=-MSR

L. 33kMSR

[Pic No.22-1] Testing for OPOS Device (Select from the menu)

"/ sAMS OPOS SET

o

File ~ Tools - Help ~

2w X[ <8
- POS Printer
I T - g
- Line Displa
- Cash Drawer
=-MSR

L S3kMER

LON Mame LDN Description Status
MNew LDN POSPrinterttGIANT-200

[Pic No.22-2] Testing for OPOS Device (Click the button)

SHC-SW-02—0OPOSSET_UserManual(Eng)
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"4 saMaS OPOS SET = = ==
File - Tools ~ Help ~
% X |J| || B
E‘ F:Oam?tezrnn LDN Name LDN Description Status
. Line Display POSPrinterttGIANT-200
- Cash Drawsr Delete LDN
= SR Rename LDM
L B3kMER
Device Test
[Pic No.22-3] Testing for OPOS Device
(1. Select a LDN. 2. Right mouse button click. 3. Select the ‘Device Test’)
2 ‘Test Device’ screen will be set depending on the selected OPOS Device
"8 samuas OPOS SET (=] = [ ==
File = Top—""
P Test Device
& %
=-POS P
L sn mds DEVICE LDN New LON
..... Line D 3 =W
- Cash POS Printer Test DEVICE STATUS
= MSR
. Claim Release Close
DeviceEnabled Async Mode Transaction
Print Test Unknown
Print Immediate Cut Paper Print Barcode
Print Normal Feed and Cut Print Image
CheckHealth Intemal
1

[Pic No.23] Test Device

SHC-SW-02—0OPOSSET_UserManual(Eng)
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